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1. OVERVIEW 

1.1. 7780M4-ASI OVERVIEW 

The 7780M4-ASI is a single card, single slot time division multiplexer for transporting up to four DVB-
ASI transport streams in a single 270Mb/s signal compatible with SMPTE 259M-C transport.  
 
 
7780M4-ASI Features: 
 

• Adjacent outputs of 7780D4-ASI unaffected by the loss of any DVB-ASI input feed at the 
7780M4-ASI TDM Mux 

• Single card TDM multiplexer for four DVB-ASI transport streams 
• Inputs may be MPTS or SPTS with a combined bandwidth of up to 210Mb/s 
• Signal transport uninterrupted by loss of any/all DVB-ASI input feeds 
• Comprehensive signal and card status monitoring via four digit card edge display or remotely 

through SNMP and VistaLINK® 
• VistaLINK® capability is available when modules are used with the 3RU 7700FR-C frame and a 

7700FC VistaLINK® Frame Controller module in slot 1 of the frame 
• Fully hot-swappable from front of frame 
• Output is a single 270Mb/s signal compatible with SMPTE 259M-C transport 
• Monitor port output is user-selectable from the four inputs 

 
 

TDM 
MUX

CONTROL/
INDICATION

VistaLINK®
Interface

LOCAL 
CONTROL

LOCAL 
INDICATION

DVB-ASI
INPUT 1

INPUT
STAGE

INPUT
STAGE

INPUT
STAGE

INPUT
STAGE

DVB-ASI
INPUT 2

DVB-ASI
INPUT 3

DVB-ASI
INPUT 4

270 Mb/s
SERIAL
OUTPUT

DVB-ASI
MONITOR 
OUTPUT

OUTPUT
STAGE

OUTPUT
STAGE

 

Figure 1-1: 7780M4-ASI Block Diagram 
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1.2. 7780D4-ASI OVERVIEW 

The 7780D4-ASI is a single card, single slot time division de-multiplexing a single 7780M4-ASI 
270Mb/s signal compatible with SMPTE 259M-C transport, used for transporting up to four DVB-ASI 
transport streams.  
 
 
7780D4-ASI Features: 

 
• Single card TDM demultiplexer for four DVB-ASI transport streams 
• Adjacent outputs unaffected by loss of any DVB-ASI input feed at the 7780M4-ASI TDM Mux 
• Fully hot-swappable from front of frame 
• Monitor port output is user-selectable from the four ASI outputs 
• Comprehensive signal and card status monitoring via four digit card edge display or remotely 

through SNMP and VistaLINK® 
• VistaLINK® capability is available when modules are used with the 3RU 7700FR-C frame and a 

7700FC VistaLINK® Frame Controller module in slot 1 of the frame 
• Occupies one card slot & can be housed in a standalone frame, a 1RU frame holding up to 3 

modules or a 3RU frame holding up to 15 modules 
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Figure 1-2: 7780D4-ASI Block Diagram 

 

 
 
 



7780M4-ASI / 7780D4-ASI 
Quad ASI TDM-Mux/Demux 

 

 Revision 1.0 Page 3 

2. INSTALLATION 

2.1. REAR PLATE DESCRIPTION 

The 7780M4-ASI and 7780D4-ASI modules occupy one card slot each and can be housed in a 
standalone frame, a 1RU frame holding up to three modules or a 3RU frame holding up to 14 modules.    
Figure 2-1 provides an illustration of the 7780M4-ASI and 7780D4-ASI rear plates.  
 

       
Figure 2-1: 7780D4-ASI and 7780M4-ASI Rear Plates 

 

2.1.1. 7780M4-ASI Connectors 
SDI Out: This BNC connector with serial digital video output is compatible with SMPTE 

259M.  This BNC carries out the compressed multiplexed content from outputs 
1, 2, 3 and 4.  The content from the SDI Output can only be demultiplexed 
using the 7780D4-ASI.  

 
Loop Out: This BNC can be used to loop out any of the 4 ASI inputs.  It is mainly used for 

troubleshooting purposes.  
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ASI Input 1, 2, 3, 4: These four BNC connectors are compatible with DVB/ATSC-ASI standards.  
The maximum input bandwidth of each input cannot exceed 205 Mb/s.     ASI 
Inputs 1, 2, 3, and 4 correspond to ASI Outputs 1, 2, 3, and 4 on the 7780D4-
ASI module.  

 

2.1.2. 7780D4-ASI Connectors 
 
SDI Input:  This BNC connector with serial digital video input is compatible with SMPTE 

259M; compliant TDM streams as provided by the companion 7780M4-ASI.  
The SDI Input connector receives a signal from the multiplexer (7780M4-ASI), 
which is to be demultiplexed by the demultiplexor (7780D4-ASI).    

 
Loop Out: This BNC can be used to loop out any of the 4 ASI inputs.  It is mainly used for 

troubleshooting purposes. 
 
ASI Output 1, 2, 3, 4: These four BNC connectors with serial digital video inputs are compatible with 

DVB/ATSC-ASI standards.  ASI Outputs 1, 2, 3, and 4 corresponds to ASI 
Inputs 1, 2, 3, and 4 on the 7780M4-ASI module.  
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2.2. HARDWARE INSTALLATION 

The following materials are required to successfully install the 7780M4-ASI and 7780D4-ASI modules: 
 

1. 1 Spare slot in an Evertz 7700 frame with Frame Controller 
2. Evertz serial cable 
3. VLPro Server IP address 

 
Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn. 
 
Unpack your 7780M4-ASI and/or 7780D4-ASI and separate the rear card from the main card. Locate 
the blank plates on the rear of the rack and remove a single blanking panel. Insert the rear plate into 
the back of the chassis and secure using the two screws provided.  
 

 
Figure 2-2: Rear View of 7700FR Frame 

 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7780M4-ASI and/or 7780D4-ASI card into the corresponding front slots ensuring the 
card lines up with the slot runners on the bottom and the top of the chassis. Push the card into the slot 
ensuring that when it mates with the rear card that is has been firmly pushed into a seated position.  
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3. TECHNICAL SPECIFICATIONS – 7780M4-ASI 

3.1. ASI INPUT 

Standard:  DVB-ASI: DVB TR 101 891-270 
Number of inputs:  4 independent DVB-ASI 270Mb/s signals 
Max Input Bitrate:  210Mb/s 
Connector:  4 BNC per IEC 61169-8 Annex A 
Return Loss:  > 15dB up to 270Mb/s 
 

3.2. OUTPUT 

Standards: 
Output:  SMPTE 259M-C framing compatible 
Monitor:  DVB-ASI output 

Total Active Bitrate:  210Mb/s 
Number:  1 + 1 monitor 
Connector:  BNC per IEC 61169-8 Annex A 
Signal Level:  800mV nominal 
DC Offset:  0V ±0.5V 
Rise and Fall Time:  900ps nominal 
Overshoot:  < 10% of amplitude 
Return Loss:  > 15dB up to 270Mb/s 
Wide Band Jitter:  < 0.2UI  
 

3.3. ELECTRICAL 

Voltage: +12VDC 
Power: 10W 
 

3.4. PHYSICAL 

Number of slots: 1 
 

3.5. COMPLIANCE 

Electrical Safety:  CSA Listed to UL 60065-03, IEC 60065 
 Complies with CE Low voltage Directive 
EMI/RFI:  Complies with FCC Part 15, Class A 
 EU EMC Directive 
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4. TECHNICAL SPECIFICATIONS – 7780D4-ASI 

4.1. ASI INPUT 

Standard:  SMPTE 259M-C compliant TDM stream as provided by  
 companion 7780M4-ASI 
Number of inputs:  1 
Connector: 1 BNC per IEC 61169-8 Annex 2 
Equalization: Automatic to 250M @ 270Mb/s with Belden 8281 or equivalent cable 
Return Loss: >15dB up to 270Mb/s 
 

4.2. OUTPUT 

Standard:  DVB-ASI: DVB TR 101 891-270 
Number of Outputs:  4 independent DVB-ASI 
Monitor Output:  1 output, selectable from outputs 1-4 
Connector:  BNC per IEC 61169-8 Annex A 
Signal Level:  800mV nominal 
DC Offset:  0V ± 0.5V 
Rise and Fall Time:  900ps nominal 
Overshoot:  < 10% of amplitude 
Return Loss:  > 15dB up to 270Mb/s 
Wide Band Jitter:  <0.2UI 
 

4.3. ELECTRICAL 

Voltage: +12VDC 
Power: 10W 
EMI/RFI:  Complies with FCC Part 15, Class A 
 EU EMC directive 
 

4.4. PHYSICAL 

Number of slots: 1 
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5. VISTALINK® REMOTE MONITORING/CONTROL 

5.1. WHAT IS VISTALINK®? 

VistaLINK® is Evertz’s remote monitoring and configuration platform which operates over an Ethernet 
network using Simple Network Management Protocol (SNMP).  SNMP is a standard computer network 
protocol that enables different devices sharing the same network to communicate with each other.  
VistaLINK® provides centralized alarm management, which monitors, reports, and logs all incoming 
alarm events and dispatches alerts to all the VLPro Clients connected to the server.  Card 
configuration through VistaLINK® PRO can be performed on an individual or multi-card basis using 
simple copy and paste routines, which reduces the time to configure each module separately.  Finally, 
VistaLINK® enables the user to configure devices in the network from a central station and receive 
feedback that the configuration has been carried out. 
 
There are 3 components of SNMP: 
 
1. An SNMP manager, also known as a Network Management System (NMS), is a computer running 

special software that communicates with the devices in the network.  Evertz VistaLINK-C 
Configuration Utility graphical user interface (GUI), third party or custom manager software may be 
used to monitor and control Evertz VistaLINK® enabled products. 

 
2. Managed devices, (such as 7780M4-ASI and 7780D4-ASI cards), each with a unique address 

(OID), communicate with the NMS through an SNMP Agent.  Evertz VistaLINK® enabled 7700 
series modules reside in the 3RU 7700FR-C MultiFrame and communicate with the manager via 
the 7700FC VistaLINK® frame controller module, which serves as the Agent. 

 
3. A virtual database, known as the Management Information Base (MIB), lists all the variables being 

monitored, which both the Manager and Agent understand.  Please contact Evertz for further 
information about obtaining a copy of the MIB for interfacing to a third party Manager/NMS. 

 
For more information on connecting and configuring the VistaLINK® network, see the 7700FC Frame 
Controller chapter. 
 
 

5.2. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7780M4-ASI and/or 7780D4-ASI jar file to the server and both the 
client and server applications have been restarted. If you are the network administrator refer to section 
8.2 for information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+”. Your 
7780M4-ASI and/or 7780D4-ASI should appear as a newly listed device under the frame you selected 
as shown in Figure 5-1.  
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Figure 5-1: VistaLINK® PRO Hardware Configuration 

 
Please consult your network administrator if you have problems connecting the card with VLPro, 
alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
 
Consult the VistaLINK® Pro manual for instruction on how to use VistaLINK® software.  
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6. CARD CONFIGURATION – 7780M4-ASI 

6.1. CONFIGURING THE 7780M4-ASI USING VISTALINK® 

Expand the Hardware tree from the VLPro window. Locate the IP address of the frame controller in 
which the card(s) has been installed. Click the “+” button to expand the frame. The card you have 
installed should be displayed as a sub component of this frame, and should be named appropriately, 
7780M4-ASI, followed by square brackets to indicate the slot number used. 
 

6.2. ASI IN 1/2/3/4 TABS 

Right-click the card and select View Configuration from the context sensitive menu. You will be 
presented first with the “ASI IN 1” tab. The following three tabs labeled ASI IN 2 / ASI IN 3 / ASI IN 4 
have identical controls and layout but refer to each of the separate inputs. For the sake of brevity, only 
ASI IN 1 will be described.   
 
The configuration screen shown in Figure 6-1 will appear on the right-hand side of the screen: 
 

 
Figure 6-1: ASI IN 1 – 7780M4-ASI  
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6.2.1. Control 
The Control section of the ASI IN 1 tab, enables the user to adjust the ASI IN controls. The following 
items provide descriptions of the controls.  
 

• Reset Measurements: The Reset Measurements button allows the user to reset the Monitor 
window. 

 
• Max Input Bandwidth (0-209 Mbits/s): This field requires a decimal value entry between 0 and 

209. Setting this control caps the maximum bitrate that will be accepted on this input. ASI 
streams which exceed this rate will be removed completely from the output. You can either 
increase the value or reduce the ASI stream rate to avoid this problem. 

 

 

Note: It is important to first consider the gross rate of all four inputs before 
making any adjustments in a production environment. The maximum 
transportable aggregate value of SDI compatible stream cannot exceed 270 
Mbits/s. The maximum input of the four streams is 209Mb/s. 

 
 

• Input Enable: It may be necessary to totally disable an input in some situations, use this drop-
down box to select if the input should be enabled or disabled.  

 

 

Note: ASI IN 1 should typically be enabled at all times. Input 1 will auto detect 
the type of input as it can accept either ASI or SDI (the other three ports only 
accept ASI). When SDI is detected the other inputs are automatically disabled 
and the SDI bypasses onto the SDI line. 

 

6.2.2. Monitor 

• Input Status:  The status of the input is displayed in this field. 
 
• Total TS Bit Rate: This field displays the total bit rate for the entire stream (including NULL 

packets). 
 
• Null Packet Bit Rate: This field displays the current bitrate of the NULL packets. 
 
• Useful Bit Rate: This field displays the actual bitrate in use (Total TS Bit Rate – Null Packet Bit 

Rate) and reflects the actual bit rate currently being used by this input. 
 
• Number of Active PIDs: This field displays the number of PIDs detected in the stream. 
 
• Number of Continuity Count Errors: This field displays the number of continuity counts that 

have been detected since the last “Reset Measurements” or reboot.  
 

 
Note: This is particularly useful during troubleshooting to determine if the 
packets are being dropped on the input. 
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6.3. SDI OUT TAB 

The SDI OUT tab controls the operation of the card and determines how the SMPTE 259M-C compliant 
stream is characterized. 
 

 
Figure 6-2: SDI OUT – 7780M4-ASI 

 
6.3.1. SDI Control 
The SDI OUT tab enables the user to set the parameters for the SDI Outputs.  
 

• Video Standard: Options are N270 if you are running in an NTSC facility and P270 if you are 
running in a PAL facility.  

 
• Vanc Mapping:  The Vanc Mapping control allows the user to enable or disable the Vanc 

Mapping function. The drop down menu options are Off or On. 
 

• Hanc Mapping: The Hanc Mapping control allows the user to enable or disable the Hanc 
Mapping function.  The drop down menu options are Off or ON. 

 
• Output Mode: The Output Mode control enables the user to set the output mode to 

Discontinuous or Continuous mode.  
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6.4. GENERAL TAB 

The General tab permits the user to set a password to protect the control and display monitored 
aspects of the board. 
 

 
Figure 6-3: General – 7780M4-ASI 

6.4.1. Control 

• Set Password:  Setting a password protects the configuration from being changed. Without the 
password it is not possible to amend the configuration.  

o This can be useful where inputs are used by separate entities or organizations and over-
bandwidth usage could cause transmission problems. 

 

 

By default the password is set to 7154.  In order to change your password, type in 
the old 4 digit password followed by the new 4 digit password and then click on 
the Apply button. 

 

6.4.2. Monitor 

• Output Bit Rate: This shows the current maximum bitrate that the M4 is able to pass.  The 
maximum is dependant upon the settings on the SDI OUT tab as detailed below: 

 
VANC HANC MAX Mb/s 

OFF OFF 160 
OFF ON 180 
ON OFF 180 
ON ON 209 

 
• Data Bit Rate: This field displays the actual bitrate being used by the four inputs.  The 

maximum useable rate is 209 Mb/s as shown above. 
 

• Firmware Version: This field displays the current firmware version on the board.  This 
information will be useful for the user when contacting Evertz technical support. 
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6.5. FAULTS 

The Fault tab allows custom configuration of the traps and displays the trap status. Use the auto-
refresh option in VLPro to see the status dynamically updating. In order to enable a trap simply click 
on the check box associated with the trap you wish to enable.  
 

 
Figure 6-4: Faults – 7780M4-ASI 

 
6.5.1. ASI Trap Enable / ASI Trap Status 
The ASI Trap Enable section allows the user to set which ASI Trap Enable controls are enabled. The 
ASI Trap Status allows the user to monitor the status of the faults.  
 

• ASI Output 1/2/3/4: This status indicator will remain red unless a valid ASI output is present.  
 

• ASI Input Bandwidth 1/2/3/4:  This trap status will change to red if the ASI input bandwidth 
exceeds the limit set by the user.  

 
• Input 1/2/3/4 Continuity Count Error:  This trap status will change to red every time the 

continuity count counter is incremented indicating a missing or lost packet. 
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7. CARD CONFIGURATION – 7780D4-ASI 

7.1. CONFIGURING THE 7780D4-ASI USING VISTALINK® 

Expand the Hardware tree from the VLPro window. Locate the IP address of the frame controller in 
which the card(s) have been installed. Click the “+” button to expand the frame. The card you have 
installed should be displayed as a sub component of this frame, and should be named appropriately, 
7780D4-ASI, followed by square brackets to indicate the slot number used. 
 

7.2. ASI OUT 1/2/3/4 

Right-click the card and select View Configuration from the context sensitive menu. You will be 
presented at first with the “ASI OUT 1” tab. The following three tabs labeled ASI OUT 2 / ASI OUT 3 / 
ASI OUT 4 have identical controls and layout but refer to each of the separate outputs. For the sake of 
brevity, only ASI OUT 1 will be described in detail.   
 
The configuration window in Figure 7-1 will appear in the right-hand side of the screen: 
 

 
Figure 7-1: ASI OUT 1 – 7780D4-ASI 

7.2.1. Control 

• Reset Measurements: The Reset Measurements button allows the user to reset the Monitor 
window. 

 
• ASI Output Mode: The ASI Output Mode control enables the user to set the output mode to 

Discontinuous or Continuous mode.  
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• ASI Output Enable:  Use the ASI Output Enable drop-down box to select if the ASI output 
should be enabled or disabled.  

 

7.2.2. Monitor 

• Total TS Bit Rate: This field displays the total bit rate for the entire stream (including NULL 
packets). 

 
• Null Packet Bit Rate: This field displays the current bitrate of the NULL packets. 
 
• Useful Bit Rate: This field displays the actual bitrate in use (Total TS Bit Rate – Null Packet Bit 

Rate) and reflects the actual bit rate currently being used by this input. 
 
• Number of Active PIDs: This field displays the number of PIDs detected in the stream. 
 
• Number of Continuity Count Errors: This field displays the number of continuity counts that 

have been detected since the last “Reset Measurements” or reboot.  
 

 
Note: This is particularly useful during troubleshooting to determine if the 
packets are being dropped on the input. 

 

7.3. SDI IN TAB 

The SDI IN tab enables the user to monitor and set the SDI input information. 
 

 
Figure 7-2: SDI IN – 7780D4-ASI 
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7.3.1. SDI Monitor 

• SDI Input Standard:  This field displays the detected SDI input standard.  
 
• SDI TDM Use Vanc:  This field displays the status of the SDI TDM Use Vanc control.  The 

options for this parameter are ON and OFF.  
 
• SDI TDM Use Hanc:  This field displays the status of the SDI TDM Use Hanc.  The options for 

this parameter are ON and OFF.  
 

• SDI Bypass:  This field displays whether the SDI Bypass is on or off.   If it is on, “Bypass” will 
be displayed in the field.      

 

7.3.2. SDI Control 
Set SDI Bypass:  The Set SDI Bypass drop down menu enables the user to select the SDI Bypass 
mode.   

• In ON mode the module will operate like a DA where any stream present at the SDI input will 
be distributed to all four ASI outputs.   

 
• In OFF mode the SDI input will not be distributed to any of the ASI outputs, the module will only 

operate as a demultiplexer.  
 

• In Auto mode if the content present at the SDI input is a valid SDI video, the signal will be 
distributed to all four ASI outputs, however if the signal contains TDM content the module will 
operate as a demultiplexer.  

 
7.4. GENERAL 

The General tab permits the user to set a password to protect the control and display monitored 
aspects of the board. 
 

 
Figure 7-3: General – 7780D4-ASI 
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7.4.1. Control 

• Set Password:  Setting a password protects the configuration from being changed. Without the 
password it is not possible to amend the configuration.  

o This can be useful where inputs are used by separate entities or organizations and over-
bandwidth usage could cause transmission problems. 

 

 

NOTE:  By default the password is set to 7154.  In order to change your password, 
type in the old 4 digit password followed by the new 4 digit password then click on 
the Apply button. 

 

7.4.2. Monitor 

• Used Link Bit Rate: This field displays the actual incoming data bitrate.   
 

• Firmware Version: This field displays the current firmware version on the board.  The firmware 
version information will be useful if contacting Evertz technical support. 
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7.5. FAULTS 

The Faults tab allows custom configuration of the traps and displays the trap status. Use the auto-
refresh option in VLPro to see the status dynamically updating. In order to enable a trap simply click on 
the check box associated with the trap you wish to enable.  
 

 
Figure 7-4: Faults Tab – 7780D4-ASI 

 
• SDI Input:  This status indicator will remain green as long as a valid SDI input is detected.   
 
• ASI Output 1/2/3/4: This status indicator will remain red unless a valid ASI Output is present.  

 
• ASI Input Bandwidth 1/2/3/4:  This trap status will change to red if the ASI input bandwidth 

exceeds the limit set by the user.  
 

• Input 1/2/3/4 Continuity Count Error:  This trap status will change to red every time the 
continuity count counter is incremented indicating a missing or lost packet.  
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8. TROUBLESHOOTING 

8.1. VLPRO DOES NOT DISPLAY THE 7780R2X1-ASI-CS ALARMS 

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been 
established check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

8.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 8-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 8-2. Simply navigate to the location of the new JAR file and 
select the file by double clicking. The window will automatically close and the update will be applied in 
the background.  
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Figure 8-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
Figure 8-3: Restart Alarm Server Message 

 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the start-up to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 
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9. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  Band Width 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 [9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
GOP Group of Pictures 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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